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CHAPTER 1

Introduction
Approximate Time: 1 hour

Welcome to the Getting Started Tutorial.

n Tutorial Goal Learning how to use MadCap Flare Desktop's basic features.

n Key Concepts Creating a project, adding elements to a project, and building PDF and HTML5
outputs.

This chapter discusses the following:

Using the Getting Started Tutorial 6

Using the San Diego Project Template 6

For More Information 7

Ready to Begin? 7
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Using the Getting Started Tutorial
The Getting Started Tutorial is designed in a self-guided format. You can go through the tutorial at
your own pace and complete as much or as little of the tutorial as you want.

The Getting Started Tutorial covers the following:

1. Starting Projects How to build a new project from a template. See "Starting Projects" on page
8.

2. Authoring How to add content to your projects, such as topics, images, cross-references,
and snippets. See "Authoring" on page 18.

3. Using Styles How to use styles to make your project look the way you want it to. See "Styles"
on page 50.

4. Developing Targets How to prepare your output using conditions, PDF and HTML5 outputs,
skins, and tables of contents. See "Developing Targets" on page 58.

5. Building Output How to build the final printed and web outputs for your project. See "Building
Output" on page 86.

Using the San Diego Project Template
While you follow the steps in the Getting Started Tutorial, you will also use Flare's San Diego
template to create a project about San Diego. This template was designed to be used alongside the
tutorial and will give you hands-on experience in Flare Desktop. As such, some settings and content
are not enabled when you first open the template. By following the steps in the self-paced tutorial,
you can add the rest of the content to the template, and even use the template for other projects.

You might want to take some time to familiarize yourself with the topics that have already been
created for the San Diego template. You can find these in the Content Explorer on the left side of
the interface. If you want, you can also select the Project ribbon at the top of the interface and click
the Build Primary button to generate output from the template right away. This gives you an idea of
how one type of output might look.
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For More Information
There is much more to learn outside of the features covered in this tutorial. Additionally, while this
tutorial covers the recommended or most efficient way to perform a task, there are usually several
other methods that you can use. Take some time to explore Flare Desktop on your own and find the
technique that is most comfortable for you. Refer to the Help system for more information about
any of the features covered in this tutorial.

For new users, we also recommend the following:

n Getting Started Guide This short PDF guide explains how Flare Desktop works and introduces
you to some of its key features and concepts. It then outlines the five basic steps for
developing a project and producing output. To download the PDF, see the Help system.

n Getting Started Video This brief movie shows you how to start a new Flare project and gives
you insight into what you should do once that is accomplished. You can view this movie from
the madcapsoftware.com website.

Ready to Begin?
To get started using the San Diego template, see "Starting Projects" on page 8.
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CHAPTER 2

Starting Projects
Begin by creating a new Flare project and taking a tour of the workspace.

This chapter discusses the following:

Creating a Project From a Template 9

Flare Desktop's User Interface 14
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Creating a Project From a Template
A template is a Flare project that already contains a few basic topics, styles, and outputs to help
you start writing quickly. After your new project is loaded, you can make any changes as necessary.

How to Create a New Project From a Template
1. When you first open Flare Desktop, you will see the Start Page in the middle of the interface.

On the Start Page, click New Project. The Start New Project Wizard opens. This is where you
can specify basic settings for your project.

2. In the Project name field, name your project San Diego.

3. (Optional) In the Project folder field, you can enter a location where you want to save your
project. By default, projects are saved in your Documents > My Projects folder.

4. Click Next.

The next screen in the wizard lets you select the kind of project you want to create: a
template, a new project based on an existing project, or an imported project. We are going to
create a project using an existing template.
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5. Under Factory Templates, expand the Tutorials folder. Select the San Diego template.
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6. Click Next.

The next screen in the wizard displays default branding for the template. You can change
branding elements such as the logo, hero image, font, and color palette to match the output
with your company's brand.
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7. In this tutorial, we are going to change the Primary branding color from orange to blue, and
then make the Secondary branding color a lighter shade of the primary color. In the Primary
field enter #6283BD, and in the Secondary field enter #DFE6F1.
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8. Click Next.

The next screen in the wizard lets you select the primary target for your project. A target is a
single instance of an output type, such as a PDF document or an HTML5 Help system. The
primary target will generate by default when you build output from Flare Desktop.

9. We only have one target set up right now (we'll add more later), so go ahead and click Finish.

The San Diego project is created and loaded into Flare Desktop.
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Flare Desktop's User Interface
Before we start opening files and adding content to them, let's take a minute to look at the main
areas of the workspace that you will use during this tutorial.

Content Explorer
The Content Explorer appears on the left side of your screen, and is where you can find all of your
content-related files. Topics appear in the main content folder. You can also create subfolders to
organize your content. By default, the Resources folder is used to organize all of your content
resources (e.g., images, snippets, multimedia, stylesheets).
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Project Organizer
The Project Organizer is also found on the left side of your screen, in the same area as the Content
Explorer. You can click the accordion tab at the bottom to switch between the Content Explorer and
Project Organizer. This is where you can find all of your project-related files, such as targets, tables
of contents, and skins. Each of these types of files appears in its own folder.
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Start Page
When you first open Flare Desktop, you will see the Start Page. Although you won't spend much
time on the Start Page, it is important because you can use it to create a new project, open an
existing project, and access various resources. Also, if you need to stop this tutorial and come back
to it later, you can reopen the San Diego project file from the Start Page's Recent Projects list.
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XML Editor
The XML Editor is located in the middle of the Flare Desktop interface. It is the primary editor that
you will use in Flare Desktop. It is used for writing, editing, and formatting content files. So once you
open a topic, snippet, or template page, it will be seen within the XML Editor.
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CHAPTER 3

Authoring
Now that you have created a project, it is time to add content to it. Adding content gives your
project some substance. You can add a variety of different features to a project.

This chapter discusses the following:

Creating Topics 19

Inserting Images 25

Inserting Cross-References 27

Inserting Drop-Down Text 32

Using Snippets 35

Inserting Tables 41

Editing Variables 46
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Creating Topics
Even though the San Diego project has a few topics already created for you, we will start by adding
a brand new topic.

How to Create a Topic
1. In the Content Explorer, right-click the Content folder. From the context menu, select New >

Topic. The Add File dialog opens.

NOTE There are several other methods that you can use to create a new topic.
However, right-clicking in the Content Explorer is the most efficient method because
you can select the folder where you want the new topic to be stored.

2. In the Add File dialog, you can select the kind of topic you want to create. In the Source area,
make sure that New from template is selected, then select NewTopic.htm from the list of
factory templates. This will create a new, empty topic.

3. In the File Name field, name the topic Famous-San-Diegans.

NOTE You don't have to use hyphens when typing a file name, like we did here. You
can run the words together or use underscores or spaces if you want, but hyphens
are recommended.
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4. In the 1st Heading field, enter the heading Famous San Diegans. If you leave this field
blank, the topic will automatically use the file name for the heading. We will leave the rest of
the fields blank for now; the default settings are okay for these fields.
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5. Click Add. Your new topic appears in the Content folder. It also opens automatically in the
XML Editor.

After closing the topic, you can reopen it later by double-clicking the file name in the Content
Explorer.

We don't want to leave this topic empty, so let's add a little bit of text to it. We will add the
names of three famous San Diegans.

6. Highlight the placeholder text and type Some famous people from San Diego are:
and press ENTER.

7. Type Cameron Diaz and press ENTER.

8. Type Tony Gwynn and press ENTER.

9. Type Sally Ride.

10. Let's create a bulleted list. Highlight the names of these three famous San Diegans. From the
Home ribbon at the top of Flare Desktop, look in the Paragraph section and click . The
paragraphs are converted to a bulleted list.
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11. Click to save your work.
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TIP Notice the left side of the topic. The side structure bars show each element's tag. You
may recognize these tags if you are familiar with XML or HTML. In this topic, we have an
<h1> tag (heading 1), a <p> tag (paragraph text), a <ul> tag (unordered list), and <li> tags
(list items).

While you don't need to know code to use Flare Desktop, you can use the structure bars to
perform a variety of tasks, including rearranging the items in the topic. After clicking one of
these bars and dragging up or down, you will see a blue arrow if you can drop an item
somewhere else in the topic. If you want, click a list item <li> tag and try dragging it up or
down in the bulleted list.

CHAPTER 3  23



If you are comfortable with XML and HTML, you can click the Text Editor tab at the bottom
of the topic. The Internal Text Editor lets you make manual changes to the markup.

CHAPTER 3  24



Inserting Images
Let's add an image to a topic to give it a little pizazz. There are already several images saved in this
project. By default, images are saved in the Resources folder, in the Images subfolder.
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How to Insert an Image
1. In the Content Explorer, double-click Food.htm. The topic opens in the XML Editor.

2. Place your cursor at the end of the paragraph about Mexican food (right after "United
States."). Then press ENTER. This creates a new space for you to either type a new paragraph
or insert other content.

3. At the top of Flare Desktop, select the Insert ribbon, and click Image. The Insert Image dialog
opens.

4. In the Select File section, navigate to Content > Resources > Images > Tacos.png.

NOTE In this case, the image is already in our project, so you can navigate directly to
it. However, if you need to insert an image that is not in the project yet, click to find
the image on your computer or network.

5. Click OK. An image of some tacos appears in the project.

6. Click to save your work.

TIP You can also drag and drop image files from the Content Explorer directly into your
topic.
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Inserting Cross-References
It is fairly common to link to other topics in a project. One way to link between topics is a cross-
reference. You may have noticed some cross-references in this tutorial already.

A benefit of using a cross-reference over a standard hyperlink is that cross-references use format
commands to update the link automatically. Format commands allow you to tell the cross-
reference to provide page number information, the title of the topic, or even a file path.

NOTE In this project and in the San Diego template, the default cross-reference style
(MadCap:xref) creates context-sensitive cross-references. In web-based output, these
cross-references look like a regular link. In print-based output, the text in the link is based
on the relationship of the cross-reference and the target location (e.g., see "Topic" on page
26; see "Topic" on the next page).

We are going to add two cross-references to our project using two different methods—the standard
method and the drag-and-drop method.
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How to Insert Cross-References Using the
Standard Method

1. In the Content Explorer, double-click Cuisine.htm. The topic opens in the XML Editor.

2. At the end of the paragraph, type See . (Be sure to leave a space after See and then type a
period.)

3. Move your cursor back, and click just in front of the final period.

4. From the Insert ribbon, select Cross-Reference. The Insert Cross-Reference dialog opens.

5. In the Link to: section, make sure Topic in Project is selected from the drop-down.

6. In the area below, you can select the topic to which you want to create a cross-reference.
Select Food.htm.

7. At the bottom of the dialog is the Cross-Reference Properties section. On the left side of this
section you can select the cross-reference style you want to use. You can also create a new
style or edit an existing one. The right side shows you the format command and a preview of
how the cross-reference appears in Flare Desktop.
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Scroll to the bottom of the XRef Class field and notice the style called "MadCap:xref." This is
the default cross-reference style and will be used by default when you insert a new cross-
reference.

8. Click OK. Flare Desktop creates a cross-reference to Food.htm using the MadCap:xref style.

9. Click to save your work.
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How to Insert Cross-References Using the Drag-
and-Drop Method
Another common way to insert cross-references is using drag-and-drop. This method automatically
uses the main MadCap:xref style, so if you don't need to choose a different style, this is a good way
to insert a cross-reference.

1. The Cuisine.htm topic file should still be open in the XML Editor. We're going to add some text
and another cross-reference after the "Food" cross-reference you already added. Your cursor
should be placed between the cross-reference (the word "Food" and the period). You want it
to display as a left bracket.

Like this:

Not like this:

If necessary, you can press the right arrow twice on your keyboard to change a right bracket
to a left bracket.

Facing the bracket away from the cross-reference ensures that the new content you type will
not become part of the link.

2. Once your cursor is facing the correct way, type and . (Be sure to leave a space before and
after and.)

3. In the Content Explorer, select Beer.htm and drag it after the word and (just before the
period) in the XML Editor.
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4. A red line appears when you can drop the topic. When the line is in the correct location,
release the mouse button. Flare Desktop creates a cross-reference to Beer.htm using the
MadCap:xref style.

5. Click to save your work.
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Inserting Drop-Down Text
If you have a very long topic, you may want to break up sections of it to make it easier to read. One
way to do this is to add drop-down text, which collapses sections of content under a single link in
the topic (called a "drop-down hotspot"). When users click the hotspot in the output, the text
expands and they can see the hidden content. If they click the hotspot again, the text collapses.

How to Insert Drop-Down Text
1. In the Content Explorer, double-click Attractions.htm. The topic opens in the XML Editor.

2. At the end of the first paragraph, press ENTER to add a new line. Then type Balboa Park.

3. Use your mouse to select the three elements that relate to Balboa Park: the text you just
added, the paragraph about the park, and the image of the fountain.

4. From the Insert ribbon, select Drop-Down Text.
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5. Flare Desktop creates a drop-down for the content you selected. The text you added earlier
(Balboa Park) now has a special style applied to it (MadCap:dropDownHotspot) to distinguish
it as a clickable drop-down hotspot. All of the content that is included in the drop-down is
surrounded by large, light gray brackets.

Let's add drop-downs for the sections about the Zoo and Petco Park.

6. Scroll down in the topic, and before the paragraph about the San Diego Zoo, add a new line
and type San Diego Zoo.

7. Use your mouse to select the three elements that relate to the San Diego Zoo: the text you
just added, the paragraph about the zoo, and the image of the panda.

8. Select Insert > Drop-Down Text to add a drop-down to this section.

9. Scroll down, and before the paragraph about Petco Park, add a new line and type Petco
Park.

10. Use your mouse to select the three elements that relate to Petco Park: the text you just
added, the paragraph about the ballpark, and the image of the ballpark.

11. Select Insert > Drop-Down Text to add a drop-down to this section.

12. Click to save your work.
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NOTE Drop-down effects are supported only in online outputs. You can still have them in
your topics if you plan to generate print-based outputs, such as PDF. However, it will just
look like regular text.

NOTE If you have been following this tutorial in order, there is not an online target in the
project yet. However, we'll revisit these drop-downs when we build HTML5 output. See
"Creating a New Target" on page 59 and "Building and Viewing HTML5 Output" on page 87.
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Using Snippets
You can use snippets in your project whenever you need to reuse the same content in more than
one place, rather than rewriting or copying it. Then, when you need to make a change, you can
modify the content in the snippet and the edits will automatically appear wherever you used the
snippet. You don't need to make the same change multiple times.

A snippet can be as short or long as you want. It can be just a few words, a sentence, or several
paragraphs. Snippets can contain any type of content, including text, images, lists, or even other
snippets.

Let's create a short snippet and place it in our project.
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How to Create a Snippet
We will use Home.htm as the first topic that opens in our online output. There is some text in this
topic that we also want to use in the Introduction.htm topic, which will be the first topic in our
PDF output. Let's create a snippet so we can reuse this content in both topics.

1. In the Content Explorer, double-click Home.htm. The topic opens in the XML Editor.

2. Scroll down so you can see the area that contains a heading, four short paragraphs, and a list.

3. Select the first three paragraphs and the entire list (the text starting with "San Diego" and
ending with "San Diegans").

4. Select the Home ribbon, and click Create Snippet. The Create Snippet dialog opens.

5. In the Snippet File field, type San-Diego-Intro. This is the name for your snippet.

6. In the Project Folder field, you can enter a location where you want to save your snippet. By
default, snippets are saved in the Content folder in the Resources > Snippets folder. This is
the recommended location for snippets, so we will not change this path.
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7. In the Snippet field, use the scroll bar to review the content. You should see exactly the
content you just selected (the text starting with "San Diego" and ending with "San Diegans").

NOTE The preview won't have any styling associated with it, so it will look somewhat
plain. That's okay. The styles will show up in whatever topic the snippet is inserted
into. But if anything else looks incorrect in the preview, you can click Cancel and start
again.

8. Make sure the check box Replace Source Content with the New Snippet is selected. Since we
want to use the snippet in the current topic, this will automatically insert the snippet into that
topic for us.
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9. Click Create. Flare Desktop creates the snippet, inserts it into the topic, and adds the snippet
file to the Content Explorer. Notice that the structure bars on the left side of the content
(representing the individual paragraphs and the list) have been replaced by a single structure
bar (i.e., the snippet block), and the snippet is surrounded by light gray brackets.

10. Click to save your work.
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How to Insert a Snippet
Now that we have created a snippet, we will insert it into another topic.

1. In the Content Explorer, double-click Introduction.htm. The topic opens in the XML Editor.

2. Click at the end of the Introduction heading and press ENTER to create a new empty
paragraph after it. This is where we will insert the snippet.

3. Select the Insert ribbon, and click Snippet. The Insert Snippet Link dialog opens.

4. In the Select Snippet section, navigate to Content > Resources > Snippets > San-Diego-
Intro.flsnp. When you select the snippet, you will see it in the Preview section so you can
confirm that you have selected the correct snippet.
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5. Click OK. The snippet appears in the topic between the main heading and the History section.

6. Click to save your work.

TIP You can also drag and drop snippet files from the Content Explorer directly into your
topic.

TIP If you need to edit a snippet, you can double-click it in the Content Explorer. It will open
in the XML Editor just like a topic. However, if you end up with many snippets over time, it
might be difficult to locate the precise snippet you need. A quicker way to edit a snippet is
to right-click on a snippet that is inserted in a topic and from the context menu select Open
Snippet File.
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Inserting Tables
You can use tables for many purposes in Flare Desktop. We are going to insert a small table into a
topic to compare some information.

How to Insert a Table
1. Open the Introduction.htm topic.

2. Scroll down to the History section of the topic. Add a new empty paragraph between the two
paragraphs in this section.

3. From the Insert ribbon, select Table (the face of the button, not the down arrow). The Insert
Table dialog opens.

NOTE If you click the down arrow below the Table button, it will open a grid that you
can use to insert a basic table. That is fine for many uses, but for this tutorial, be sure
to click the face of the button—not the arrow—so you can configure some properties
in the Insert Table dialog.
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4. In the Table Size section, use the arrows to make the following changes:

a. Set the Number of columns to 2.

b. Set the Number of rows to 4.

c. Set the Number of header rows to 1.

As you change these settings, the table in the Preview section updates to show you how your
table will appear in Flare Desktop.
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5. In the Table Style section, from the Table Style drop-down, select Alternate-Row-Color.css.

6. Click OK. The empty table appears in the History section.

Let's add some data to our table.

7. Click in the upper-left cell of the table. This is your header row. Type Historical
Affiliation.

8. Click in the upper-right cell of the table. Type Date.
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9. In the Historical Affiliation column, type the following:

a. In the first cell, type Spanish Empire.

b. In the second cell, type First Mexican Empire.

c. In the third cell, type United Mexican States.

d. In the fourth (bottom) cell, type United States.

10. In the Date column, type the following:

a. In the first cell, type 1769–1821.

b. In the second cell, type 1821–1823.

c. In the third cell, type 1823–1848.

d. In the fourth (bottom) cell, type 1848–present.

11. Click to save your work.
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What are Table Styles?
Flare Desktop uses table styles to determine the look of a table. They are a useful way to make sure
all of your tables have a consistent look. For example, you can use a table stylesheet to determine
the colors for your table's rows and columns, or for its borders. You can apply the table style to one
table or to all of the tables in your project. Table styles are handled separately from regular
stylesheets. You can also use table styles to set default styles for the cell content.
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Editing Variables
Variables contain short pieces of information that appear throughout a project, like your company
name, website, and product name. You can create variables for just about anything. Variables work
sort of like snippets: you can use them throughout your project, and when you make a change to
them, the changes will appear anywhere you used the variable. This makes variables a great option
for information that might change frequently, such as dates or version numbers.

When you use the San Diego template, Flare Desktop automatically adds a few standard variables
to your project. Let's edit some of these variables so our finished project will be a little less generic.
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How to Edit a Variable
Up to this point, we have been working with resources that are stored in the Content Explorer.
Variables are a project resource, so they are located in the Project Organizer.

1. On the left side of Flare Desktop, open the Project Organizer.

2. Expand the Variables folder.

3. Double-click the General variable set. The Variable Set Editor opens to the right.

Look at the different variables in this project. There are variables for the company name,
street address (including a separate variable for the city, state, and zip code), phone number,
website, and current year. There is also a variable for the title of the PDF guide.

The name of each variable appears in the Name column. The content that will appear in the
output wherever the variable is used appears in the Definition column. Let's edit some of the
variable definitions.

4. In the Definition column, double-click My Company, LLC. In the field, enter the name of your
company and press ENTER.
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5. (Optional) In the Definition column, double-click and change the definition for any other
variables that you want to customize.

NOTE You might have noticed that the Year variable has a slightly different icon,
which uses a clock . This indicates that it is a Date/Time variable, which uses
format specifiers to represent the date or time. The Year variable uses the format
"yyyy" to represent the current year (in 4-digit format).

For more information about formatting and using Date/Time variables, see the Help
system.

6. Click to save your work.
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EXAMPLE After you finish renaming variables, you can look at them in a content file (topic,
snippet, template page, page layout). Open the Content Explorer, then expand Resources >
TemplatePages folder. Double-click Home-Page.flmsp.

All of the gray highlighted fields on this page are variables. Using the Show Tags drop-
down field in the local toolbar of the XML Editor, you can adjust your markers to display
inserted variables in different ways (e.g., show/hide the variable name in the editor).

If you were to edit the variables again, and then come back to this file, you would see the
updated information.
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CHAPTER 4

Styles
There are lots of ways in Flare Desktop to make your output look good. In this tutorial we're going to
focus on the most common way to control the look of your documentation—styles. However, keep
in mind that this tutorial only scratches the surface of how to use styles.

This chapter discusses the following:

Creating Style Classes 51

Applying Styles 56

CHAPTER 4  50



Creating Style Classes
You can use styles in your projects to format elements. Although you can use local (or inline)
formatting (such as selecting a single word and using the Color button on the Home ribbon to make
it red), using styles instead will save you time. If you edit the properties for a style in the stylesheet,
that change will automatically be made anywhere you used the style class. You do not need to go
back and make the change in every topic.

After you create a new Flare project, you'll see that there are already many styles for you to use. And
you can change the properties for any of those styles to adjust the look.

In addition to using the styles that are already in place, you may find the need now and then to
create your own style class. Think of a style class as a "child" of a "parent" style. A style class gives
you more flexibility when using a style. For example, you might create a red h1 (heading 1) style
class and a blue h1 style class. These would both be children of the h1 style (e.g., h1.red, h1.blue).

How to Close Open Files
Before we continue, let's close the files that we've already opened. This is a good thing to do as you
work so that you don't have so many items open, which can cause performance issues later. You
can close files one at a time by clicking the small x on the right side of each tab, but a quicker way is
to use an option to close them all at once.

1. Select the Window ribbon.

2. Click Close All Documents. This closes everything except the Start Page.

TIP If you want to close all of the files except one of them. Open that file, then instead of
clicking the face of the "Close All Documents" button, select the down arrow and choose
Close All But This.
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How to Create a Style Class
We are going to create a style class of the parent image (img) style. Then we will modify our style
class so that it turns online images into thumbnails. In other words, images will initially display very
small but when they are clicked in online output, they will be shown at the full size in a popup.

1. In the Content Explorer, open Resources > Stylesheets.

2. Double-click the Styles.css stylesheet. The Stylesheet Editor opens to the right.

3. You can use the Simplified or Advanced view when editing a stylesheet. Let's use the latter. In
the local toolbar of the Stylesheet Editor, make sure the first button is labeled View:
Advanced. If it says View: Simplified, click it so that it change to the Advanced view.

4. In the upper-left of the editor, set the drop-down to to make it easier
to find the style.

5. In the Styles section, select img.

6. In the local toolbar of the editor, click . The New Selector dialog opens.
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7. In the Class Name field, type thumbnail.

8. Click OK. The thumbnail style class appears in the stylesheet, indented under the img parent
style.

The style class is added, but the only properties it has right now are the ones it has inherited
from the img style. Now we need to add unique properties to the thumbnail style class.

CHAPTER 4  53



9. With the new thumbnail class selected, from the Show field in the upper-right corner of the
editor, select . This will display only the properties that are
related to images, making it a lot easier to find the properties that you need to set.

10. Make sure the properties on the right side of the editor are shown in group view, which means
there will be different categories that you can expand and collapse. In the local toolbar, you
should see a Grouped View button . If instead you see the Alphabetical View button ,
click it to switch to Group View.

11. Expand the Thumbnail group.
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12. Next to the mc-thumbnail property, click and select popup. We will leave the other
thumbnail settings as they are.

13. Click to save your work.
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Applying Styles
Now that we have created the thumbnail style, we can apply it to an image.

How to Apply a Style
1. In the Content Explorer, double-click Attractions.htm. The topic opens in the XML Editor.

2. Select the Home ribbon, and click Style Window. The Styles window pane opens on the right
side of the Flare Desktop interface.

The Styles window pane displays formatting options for the text that is currently selected. For
example, if you have clicked in a paragraph, you will see several styles for formatting text,
such as heading styles and any children of the parent p style.

3. In the XML Editor, select the image of the fountain so that it is highlighted. In the Available
Styles section of the Styles window pane, the style that is currently applied to the image of
the fountain (i.e., the img style) is shown at the top and highlighted in the list below.
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4. In the Styles window pane, click img.thumbnail. In the XML Editor, the image of the fountain
shrinks to the dimensions for the thumbnail (as specified in the stylesheet).

5. Apply the img.thumbnail style to the image of the panda and the image of Petco Park.

6. Click to save your work.

NOTE If you want, you can apply the img.thumbnail style to other images in the San
Diego project.

CHAPTER 4  57



CHAPTER 5

Developing Targets
After your project is styled, you are ready to start preparing your output files. You can set up
different output types (e.g., PDF, HTML5, EPUB) and define settings that tell Flare Desktop what
information to include in the final documents.

This chapter discusses the following:

Creating a New Target 59

Using Conditions 63

Changing Logos 75

Using a Table of Contents 81
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Creating a New Target
When you want to produce a new kind of output, you need to add a target to your project. A target is
a single instance of an output type, such as a PDF, a Help system, an eBook, or a Word document.
You can create as many targets as you need to.

Right now, the San Diego project is set up so you can build a single PDF target. However, we also
want to create an online target. The type of online output we recommend is HTML5.
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How to Create a New HTML5 Target
1. In the Project Organizer, right-click the Targets folder. From the context menu select Add

Target. The Add File dialog opens.

2. In the Add File dialog, you can select the kind of target you want to create. In the Source area,
make sure that New from template is selected, then select MyTarget from the list of factory
templates (this should be selected by default). This will create a new target with default
settings selected.

3. From the Output Type drop-down, select HTML5.

4. In the File Name field, enter All-About-San-Diego-HTML5.

5. Click Add. The new target is added to the Targets folder in the Project Organizer.
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How to Set the Startup Topic for a Target
We will use a special topic (Home.htm) for the landing page in our online target.

1. The editor for your new target should already be open. But in case it isn't, double-click the All-
About-San-Diego-HTML5 target in the Project Organizer.

2. In the Target Editor, select the General tab.

3. Next to the Startup Topic field, click . The Select File dialog opens.

4. In the list of topics, select Home.htm.

5. Click Open. Home.htm is now associated as your target's startup topic.

NOTE The home page we are using for our HTML5 startup topic uses its own template
page, which is already set up for you. This is why it has a different look and feel than the
other pages.
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How to Set the Template Page for a Target
This project has been set up so that the Home page has a different design than the rest of the
pages. This is done with a combination of template pages and styles. We've already associated the
Home page with its own template page, but now we need to tell Flare Desktop to use the other
template page for the rest of the topics. The best way to do this is to associate the template page
with the target. All topics will therefore use that template page in the output, except the Home page.

1. In the Target Editor, select the Advanced tab.

2. Scroll down, and from the Template Page drop-down, select Other-Topics.

3. Click to save your work.
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Using Conditions
The San Diego project has condition tags set up for print-based and online output. In this lesson we
will apply these conditions to a couple of paragraphs.

How to Apply Condition Tags
1. In the Content Explorer, double-click Introduction.htm. The topic opens in the XML Editor.

2. Right-click the snippet under the heading that you inserted previously. In the context menu,
click Open Snippet File.

The snippet opens in a new tab.
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3. Right-click the p structure bar to the left of the paragraph that begins “In this PDF guide…”

4. From the context menu, select Conditions.
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The Condition Tags dialog opens. In this dialog, you can see the Default condition tag set.
There are some conditions in the set: Mobile, PrintOnly, ScreenOnly, Tablet, and Web.

NOTE In your own project, you can create as many condition tag sets and conditions
as you need. And you don't need to use the ones provided in the Default condition tag
set. They're simply a starting point for you.

5. Since we want this heading to appear in our PDF, select the check box next to PrintOnly.
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6. Click OK.

NOTE If you have the condition indicators enabled, the entire paragraph is
highlighted red (this color does not display in the output). To hide the color, click
in the bottom toolbar of the XML Editor to disable the indicator.

7. Click to save your work.

Now we will apply the other condition tag to the next paragraph. But this time we're going to
do it a little differently. Conditions can also be associated with styles, so we're going to use
that method.

8. If you haven't yet closed the stylesheet, you can click the Styles.css tab at the top of the
editor area. Otherwise, in the Content Explorer, navigate to Resources > Stylesheets and
double-click Styles.css. The Stylesheet Editor opens.

9. In the local toolbar, click Add Selector. The New Selector dialog opens.

10. Previously in this tutorial, we created a class of the parent img style (see "Creating Style
Classes" on page 51). But now we're going to create something called a "generic style class."
This class will not be directly associated with any parent style, which means that any parent
style can use it. In the HTML Element field, clear any text in it.
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11. In the Class Name field, type OnlineOnly.

12. Click OK.
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13. In the Stylesheet Editor, click in the drop-down in the upper-left corner and select All Styles.

14. In the list of styles below, expand (Generic Classes).

15. Select OnlineOnly, the class you just created.
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16. In the Show drop-down field in the upper-right corner, select Show: All Properties.

17. Scroll down and expand the Unclassified group below.
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18. Scroll down until you find the mc-conditions property and click to the right of it.

The Condition Tags dialog opens.

19. Since our new generic style class is intended for online content only, select the check box
next to ScreenOnly.

20. Click OK.

21. Click to save your work.

22. Now we will apply that new generic style class to one of the paragraphs in our snippet. Go
back to the San-Diego-Intro.flsnp snippet (remember, you can click its tab at the top of the
editor area).

23. Right-click the p structure bar just to the left of the sentence that begins with “This website…”
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24. In the context menu, select Style Class and then choose .OnlineOnly.
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If you have condition indicators turned on, the entire paragraph is highlighted blue.

This second method might seem like a lot of steps, but remember, creating the style class
and associating a condition with it is a one-time setup. Once that is done, you can apply the
generic style class to any parent tag (e.g., p, ol, img) that you want to be shown only in online
output. And that's a very quick task.

25. Click to save your work.
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How to Associate Condition Tags With a Target
You have applied condition tags to content, but they won't do anything if you don't also associate
them with the targets you are going to build. Associating the condition tags with a target tells Flare
Desktop which conditions to include or exclude when building the output.

We have already associated conditions with the PDF target for you. But you still need to associate
conditions with your new HTML5 target.

1. In the Project Organizer, expand the Targets folder.

2. Double-click the All-About-San-Diego-HTML5 target. The Target Editor opens to the right.

3. Select the Conditional Text tab. This tab lets you select which conditions will be included and
which will be excluded from the output.

4. Select the Default.PrintOnly row so that it is highlighted.

5. In the Action section on the right, click Exclude. We do not want to see content marked with
the print condition in the HTML5 target.

6. Select the Default.ScreenOnly row so that it is highlighted.

7. In the Action section on the right, click Include. We do want to see content marked with the
screen condition in the HTML5 target.

CHAPTER 5  73



NOTE You might be wondering about the other tags (Mobile, Tablet, and Web) and
the “Display by Media Query” section under the Include and Exclude options. Those
can be used if you want to limit the content with the condition to certain devices (i.e.,
you can specify that something should be shown only when viewed on a large screen,
a tablet screen, or a mobile phone screen). We’re not going to cover those options in
this tutorial, but you can learn all about them from the Help system.

8. Click to save your work.
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Changing Logos
When you created the project using the Start New Project Wizard, recall the page with branding
elements. In addition to changing the primary and secondary branding colors, you can specify more
colors, logo, font, and a hero image. The branding you set customizes your project's look.

How to Change the Logo
One of the first things you will probably do is add your company or product logo. Note that setting
the logo and other branding can easily be done when creating a new project with the Start New
Project Wizard, but in this case, we skipped updating the logo. Let's update the logo now.

1. In the Content Explorer, expand Resources > Branding.

2. Double-click Branding.css. The Branding Editor opens.

The Branding Editor is essentially the same thing as the Start New Project Wizard's branding
page. You can open the Branding Editor anytime as a standalone editor after a project is
created.

During project creation a branding stylesheet (e.g., Branding.css) is added that identifies
values for branding elements. The values are associated with those CSS variables in the
project.
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3. In the Images section, let's update the generic "Your Logo" image to one that says "San Diego,
CA" for both online and print output.

4. From the LogoImage field, click to select an image. The Insert Image dialog opens.

5. In the Select File section, expand Resources > Images (if it is not already), and select SD-
Logo-Online.png. Click OK.

6. From the LogoImagePrint field, click to select an image.

7. In the Insert Image dialog, select SD-Logo-Print.svg, and click OK.

NOTE Templates that include a PDF allow you to select a vector image (e.g., EPS,
SVG), which is made up of geometric elements and provides more clarity for printed
output.
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Notice in the Branding Editor that the logo fields update and the Preview area dynamically
changes to show the selected images.

8. Click to save your work.

NOTE If you start your project with the wizard, the CSS variables are automatically
linked to various places throughout the project where they point to the branding
stylesheet. Because of this, the home template page which controls the look of the
Home page for online output is automatically updated with the new logo. You can
view this in the Content Explorer. Expand Resources > TemplatePages, and double-
click Home-Page.flmsp.

And the page layout template that is used for the PDF output is updated as well. You
can view this in the Content Explorer. Expand Resources > PageLayouts, and double-
click Frontmatter.flpgl.
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Online Output and Skins
With online output, skins are another way to provide structure and style to a page with a pre-
designed look and feel for the container displaying the final result. They let you select a logo and
colors that are defined from the branding page, as well as set fonts and more for the area that
surrounds the main topic content.

We could have discussed skins earlier in "Styles" on page 50, but skins need to be linked to an
online target and we hadn't created our HTML5 target yet. So we'll take a look at skins now.

1. In the Project Organizer, expand the Skins folder.

2. Double-click the Top-Navigation skin. The HTML5 Skin Editor opens to the right.

3. Select the Styles tab. The skin style groups and properties are on the left side and a dynamic
preview area is shown on the right side. By dynamic, we mean that you can actually click in
the preview area and navigate to different parts of the skin. Notice the branding elements are
evident in skins.

Also notice the mediums at the top of the editor (Web, Tablet, Mobile, and Print). These let
you provide different style settings for the skin, depending on the size of the device. In this
tutorial, we're only going to concern ourselves with the Web medium.
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4. Let's look at the Logo style group in the skin. It is pretty easy to spot on the left side of the
editor. But sometimes it can be a bit more difficult to find the style you need to change. So
here's a little trick. In the local toolbar of the editor, click Highlight.

This button synchronizes the styles on the left with whatever you click in the preview area.
Let's try it. In the preview, click the logo.

The Logo style group on the left is selected and its properties are expanded.

5. Under the Logo properties, expand the Background section. You can see the Image field is
referencing the CSS variable from the branding stylesheet.
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How to Assign a Skin to a Target
Now that we've created the skin, we can assign it to the HTML5 target we created.

1. From the tab at the top of the editor area, or from the Project Organizer, open the All-About-
San-Diego-HTML5 target. The Target Editor opens to the right.

2. Select the Skin tab.

3. In the Skin field, select Top-Navigation.

4. Click to save your work.
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Using a Table of Contents
Let's create a table of contents (TOC) to organize the topics that will go into our targets.

But as you do this, keep something very important in mind. A TOC file in online output acts as your
online navigation. But for print-based outputs, a TOC file acts more like an outline; it's simply used
to tell Flare Desktop which topics should be included in the print output and in what order. The
actual generated TOC in print-based outputs is done a bit differently. It uses something called a
"TOC Proxy." See the Help system for more information.

In the San Diego template, there are two TOC files already created for you—one for printed output
and one for online output. Since we added a topic to this project earlier (Famous-San-Diegans.htm;
see "Creating Topics" on page 19), we need to add that topic to these TOCs before we can build our
outputs.

How to Add a Topic to the Online TOC
1. In the Project Organizer, expand the TOCs folder.

2. Double-click Online-TOC. The TOC Editor opens to the right.

3. Open the Content Explorer.

4. In the Content Explorer, select Famous-San-Diegans.htm and drag it to the TOC Editor on the
right. You will see a blue arrow when you can drop it. Drop the topic under Cuisine.
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If you click elsewhere in the TOC, you’ll see that your new TOC entry is blue, like the others.
This doesn’t mean that the text will show up as blue in the output. Instead, what it means is
that the TOC entry contains a system variable. This variable is called “LinkedTitle.” It means
that the TOC entry text is tied to the title for that topic. If the title for the topic changes, the
TOC entry will automatically change too so that you don’t have to remember to do it
manually. See the Help system for more information.

NOTE You don’t need to use system variables for your TOC entries. Instead, you can
override a system variable by simply typing whatever text you want in place of the
blue variable text. If you do that, the text will display as black in the TOC Editor.

NOTE This topic should appear under Cuisine, but not on the same level as Food and
Beer. If Famous San Diegans drops on the same level as Food and Beer, use the blue
arrow in the local toolbar of the TOC Editor to move it to the same level as
Cuisine.

5. Click to save your work.
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How to Add a Topic to the Print TOC
Adding a topic to the Print TOC follows basically the same steps. However, there are a few
additional steps because you must set printed output settings for the new topic.

1. In the Project Organizer, expand the TOCs folder.

2. Double-click Print-TOC. The TOC Editor opens to the right.

3. In the Content Explorer, select Famous-San-Diegans.htm and drag it to the Print TOC. You will
see a blue arrow when you can drop it. Drop the topic under Cuisine and before Resources.

NOTE Remember that the Print TOC will function as an outline, rather than a true
TOC. So even though the TOC entries are blue (linked to a system variable), this
doesn’t really matter. This TOC only determines which topics will be included in the
output, but the labels on the TOC entries will not be used in the output; they are
simply for your information.

4. In the TOC Editor, double-click Famous San Diegans. The Properties dialog opens.

NOTE If double-clicking a TOC entry opens the topic instead of the Properties dialog,
click in the local toolbar of the TOC Editor to toggle the double-click behavior.

CHAPTER 5  83



5. Select the Printed Output tab.

Famous San Diegans should be a new chapter in our PDF guide, so we will set it up to use
these settings.

6. In the Break Type field, select Chapter Break.

7. In the Page Layout field, select Chapters. This is a page layout that is included with the San
Diego template.

8. Click OK. When you build the PDF output, you will notice these settings.

9. Click to save your work.

NOTE There's more to preparing a project for print-based output than what we're showing
you here. How much is involved depends on how intricate you want to get with your output.
See the Help system for more information.
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How to Assign a TOC to a Target
The Print TOC file is already associated with our PDF target. But we still need to assign the Online
TOC file to our new HTML5 target.

1. In the Project Organizer, expand the Targets folder.

2. Double-click the All-About-San-Diego-HTML5 target. The Target Editor opens to the right.

3. Select the General tab.

4. In the Primary TOC field, select Online TOC.

5. Click to save your work.
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CHAPTER 6

Building Output
After your targets are prepared, you are ready to build your final output. In this tutorial, you will build
HTML5 and PDF output.

This chapter discusses the following:

Building and Viewing HTML5 Output 87

Building and Viewing PDF Output 90
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Building and Viewing HTML5 Output
When you have finished adding all of your content to the project and made sure all of the styles and
target settings are set, you are ready to build your final output.

How to Build HTML5 Output
1. In the Project Organizer, expand the Targets folder.

2. Double-click the All-About-San-Diego-HTML5 target.

3. In the local toolbar of the Target Editor, click . The Builds window pane opens at the
bottom of the Flare Desktop interface, and the target begins to build.

NOTE The Builds window pane opens automatically when you generate a target. You can
monitor the progress of the target's build status in this pane. As the target is building, you
will see a light green progress bar in the Build Progress column. When the build completes
successfully, the progress bar turns dark green. If an error prevents the build from finishing,
the bar turns red and the build stops.

For more in-depth information about the information in the Builds window pane, please see
the Help system.

NOTE There are several other ways to build a target, including from the Builds window
pane and from the Project ribbon.
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How to View HTML5 Output
After you have built your output, you can view it. In the Builds window pane, you can double-click the
row. Alternatively, in local toolbar of the Target Editor, you can click . The HTML5 output
opens in your default web browser.

TIP You can set Flare Desktop to open output automatically when the build is finished. To
do this, select File > Options. In the Options dialog, select the Build tab, then select the
check box next to View output after successful build.

NOTE If you build output while using a trial version of Flare Desktop, you will see jumbled
characters in your output. After you become a licensed user, you will be able to build output
normally.
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Review the San Diego Project in HTML5 Output
We have made many changes to the San Diego project. Following is a list of things you might want
to look at in the HTML5 output. When you build your PDF output (see "Building and Viewing PDF
Output" on the next page), compare the two and see how these items differ.

n Home Page Look at the startup topic. Notice how it has a different look and feel from the rest
of the topics. That's because it is using a different template page and styles. Also notice the
new logo at the top and bottom of the page.

n Snippets and Condition Tags Open the Introduction topic, and notice the content at the top
that is contained in a snippet. It looks just like the rest of the content in the topic. Also notice
that the condition was applied correctly in the snippet so that the paragraph mentioning a
website displays, but not the paragraph talking about PDF output. You can open the Home
page (by clicking the logo) to see the same snippet.

n Cross-References Test the cross-reference links in the Cuisine topic.

n Drop-Down Text and Images In the Attractions topic, test the drop-down text. Also click the
thumbnail images.

n Table of Contents Notice the way the navigation works in HTML5 output and how it differs
from the table of contents in PDF output. In HTML5 Top Navigation output such as this, the
TOC is converted to menus (hover over the Cuisine item at the top to see what we mean).
Also, if you open any of the topics (other than the Home page), you will see a context-
sensitive menu on the right side; that's because the template page associated with those
topics was set up to display this.
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Building and Viewing PDF Output
Now let's build the PDF output.

How to Build PDF Output
1. In the Project Organizer, expand the Targets folder.

2. Double-click the All-About-San-Diego-PDF target.

3. In the local toolbar of the Target Editor, click . The Builds window pane opens at the
bottom of the Flare Desktop interface, and the target begins to build.
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How to View PDF Output
After you have built your output, you can view it. In the Builds window pane, you can double-click the
row. Alternatively, in local toolbar of the Target Editor, you can click . PDF output opens in
your default PDF viewer.
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Review the San Diego Project in PDF Output
Following is a list of things you might want to look at in the PDF output. When you build your
HTML5 output (see "Building and Viewing HTML5 Output" on page 87), compare the two and see
how these items differ.

n Snippets and Condition Tags Open the Introduction chapter, and notice the content at the top
that is contained in a snippet. It looks just like the rest of the content in the topic. Also notice
that the condition was applied correctly in the snippet so that the paragraph mentioning the
PDF guide displays, but not the paragraph talking about a website.

n Cross-References Look at the context-sensitive cross-references in the Cuisine chapter.
Notice the page number and reference to "the next page" instead of just providing the names
of the headings.

n Drop-Down Text and Images In the Attractions chapter, notice that the drop-down effects
display as regular text. You'll also see some light gray horizontal lines. These are associated
with the drop-down style in the stylesheet. So they might be more appropriate for online
output but not such much for print output. If you want to get rid of them in the PDF output,
you can use the Print medium in your stylesheet to remove the bottom border from the
MadCap|dropDown style .

Also, notice that the images on these pages are full size, not thumbnails.

And finally, if you notice a heading at the bottom of a page that you want to push to the next
page, you can do this easily with page breaks
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APPENDIX

PDFs
The following PDFs are available for download from the Help system.

Tutorials
Autonumbers Tutorial

Back-to-Top Button Tutorial

Context-Sensitive Help Tutorial

Custom Toolbar Tutorial

eLearning Tutorial—Basic

eLearning Tutorial—Advanced

Getting Started Tutorial

Image Tooltips Tutorial

Lists Tutorial

Meta Tags Tutorial

Micro Content Tutorial—Basic

Micro Content Tutorial—Advanced

Responsive Output Tutorial

Single-Sourcing Tutorial

Snippet Conditions Tutorial

Styles Tutorials

Tables Tutorial

Word Import Tutorial
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Cheat Sheets
Context-Sensitive Help Cheat Sheet

Folders and Files Cheat Sheet

Learning & Development Cheat Sheet

Lists Cheat Sheet

Micro Content Cheat Sheet

Print-Based Output Cheat Sheet

Search Cheat Sheet

Shortcuts Cheat Sheet

Structure Bars Cheat Sheet

Styles Cheat Sheet
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User Guides
Accessibility Guide

Analysis and Reports Guide

Architecture Guide

Autonumbers Guide

Branding Guide

Condition Tags Guide

Context-Sensitive Help Guide

Eclipse Help Guide

eLearning Guide

Flare Online Integration
Guide

Getting Started Guide

Global Project Linking Guide

HTML5 Guide

Images Guide

Import Guide

Indexing Guide

Key Features Guide

Lists Guide

Meta Tags Guide

Micro Content Guide

Navigation Links Guide

Plug-In API Guide

Print-Based Output Guide

Project Creation Guide

QR Codes Guide

Reviews & Contributions With
Contributor Guide

Scripting Guide

Search Guide

SharePoint Guide

Skins Guide

Snippets Guide

Source Control Guide: Git

Source Control Guide:
Perforce Helix Core

Source Control Guide:
Subversion

Source Control Guide: Team
Foundation Server

Styles Guide

Tables Guide

Tables of Contents Guide

Targets Guide

Template Pages Guide

Templates Guide

Topics Guide

Touring the Workspace Guide

Transition From FrameMaker
Guide

Translation and Localization
Guide

Variables Guide

Videos Guide

What's New Guide
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